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MS Word 2007 tutvustus

Üks kasutatavamaid vahendeid arvutil peale mängude ja interneti on tekstitöötlus. Tekstitöötlusega ning dokumentide koostamise ja kasutamisega tegeleb suuremal või vähemal määral iga arvutikasutaja. Tekstiredaktoreid (so tekstitöötlusprogramm) iseenesest on palju, ning nendest on enamlevinud Microsoft Word, mis kuulub Microsoft Office kontoritarkvarapaketti.

Microsoft Word 2007 on käepärane ja kergesti omandatav tekstitöötlustarkvara. Lisaks tavafunktsioonidele sisaldab programm mitmesuguseid spetsiifilisi vahendeid, mis aitavad koostada erineva keerukusastmega dokumente lisades sinna tabeleid, jooniseid, skeeme jm.
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[image: ]



[bookmark: _Toc203285365][bookmark: _Toc248637380]

MS Word ekraanipilt ja töökeskkonna elemendid

Wordi vana kujundusega menüüde ja nuppude asemel on nüüd uus lint ( ing. Ribbon) vahekaartidega. Lint tõstab esile kõige populaarsemad käsud, et te ei peaks neid sagedaste toimingute jaoks programmi erinevatest osadest otsima. Uue kujundusega tutvudes näete, et käsud on rühmitatud teie jaoks loogilisel viisil. Kõik vajalik on nüüd selgemalt näha ja paremini kättesaadav.
 (
menüü
riba
) (
tiitelriba
)

 (
kerimisriba
) (
tekstikursor
) (
I
) (
Lint
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 (
olekuriba
)

Tiitelribal kuvatakse dokumendi ning programmi nimi.
Menüüribal vajaliku menüü nimel klõpsates avaneb lint, kust saab valida sobiva korralduse. 
Tekstikursor näitab kohta, kuhu hakkate teksti sisestama.
Juhul, kui kogu info ei mahu aknasse, võimaldab kerimisriba infot aknas kerida.
Ekraani allosas olevale olekuribale (Status Bar) on kuvatud informatsioon avatud lehekülje, sektsiooni ja kursori asukoha kohta.
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Wordi tööriistad: vahekaardid, rühmad ja käsud

[image: Lindil on kuvatud menüüd, jaotised ja nupud]


Lint koosneb kolmest osast: vahekaardid, rühmad ja käsud.

1. Vahekaardid. Neid on kokku seitse. Igaüks neist tähistab Wordis tehtavaid põhitoiminguid.
2. Rühmad. Iga vahekaart sisaldab seotud üksuste rühmi.
3. Käsud. Käsuks võib olla nupp, boks, kuhu saab teavet sisestada, või menüü.

Wordi põhikäsud on koondatud esimesele vahekaardile, milleks on Home (Kodu).  Sellel vahekaardil olevaid käske kasutatakse töölehel kõige sagedamini.

Rühmad koondavad kokku kõik käsud, mida teil võib mõne kindla toimingu juures vaja minna, kusjuures need jäävad kuvatuks ja kergesti kättesaadavaks kogu toimingu ajal, mitte ei ole menüüde varjus. 
Näiteks käsud Copy, Cut, Paste on paigutatud esimesena vahekaardi Home rühma Clipboard (Lõikelaud).  Järgmisena on toodud fondi vormindamise käsud rühmas Font (šrifti tüüp, suurus, värvus jne). Teksti keskele, vasakule ja paremale joondamise käsud asuvad rühmas Paragraph (Lõik)
. 
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Uus Microsoft Office'i nupp 

Microsoft Office'i nupp  [image: Nupu pilt] kuvatakse akna ülemises vasakus nurgas mitmes Microsoft Office'i programmis. See sisaldab samu põhikäske, mis enne asusid menüüs File ja mille abil saab dokumente avada, salvestada ja printida


[image: ]



Lisaks võimaldab Microsoft Office'i nupp teile juurdepääsu programmisätetele (Word Options), mille abil saab näiteks määrata õigekirja kontrollimise eelistused. Klõpsake menüü allosas olevat käsku Word Options, (Wordi suvandid)  ning klõpsake seejärel mis tahes kategooriat vasakul olevas loendis.
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Täpsemate suvandite kasutamine - Dialoogiaknad

Kui te näete rühma alumises paremas nurgas seda noolt [image: Nupu pilt] (seda nimetatakse dialoogiboksi käivitiks), on selle rühma puhul saadaval rohkem suvandeid. Klõpsake noolt, mispeale kuvatakse dialoogiaken või tööpaan.

Näiteks vahekaardi Home rühmas Font on olemas kõik käsud, mida fondi muutmisel kõige sagedamini kasutatakse, sealhulgas käsud fondi suuruse muutmiseks või paksu, kursiivis või allakriipsutatud fondi kasutamiseks. Kui teil läheb vaja rohkem suvandeid, klõpsake noolt [image: Nupu pilt], mis asub paremal pool käsku Font. Seejärel kuvatakse dialoogiboks, mis sisaldab nii ülaindeksit kui ka teisi fondiga seotud suvandeid

[image: ][image: Lint ja dialoogiboks Font]

[bookmark: _Toc203285369][bookmark: _Toc208659527][bookmark: _Toc248637384]

Kiirpääsuriba

Kiirpääsuriba on lindist üleval vasakul asuv väike ala. See sisaldab käske, mida te pidevalt kasutate: Salvesta, Võta tagasi ja Korda. Sinna võite lisada oma lemmikkäsud, et need oleksid kogu aeg käepärast, mis tahes menüüs te parasjagu ka ei asu.

[image: ]


Näiteks kui te kasutate pidevalt tabelit ja ei taha iga kord klõpsata vahekaarti Insert, et pääseda käsuni Table, võite käsu Table lisada kiirpääsuribale. Selleks paremklõpsake vahekaardi Insert käsku Table ja seejärel klõpsake käsku Add to Quick Access...

[image: ]

Valmis!
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Kui soovite sellelt tööriistaribalt mõne nupu eemaldada, paremklõpsake nuppu ja siis klõpsake käsku Remove from Quick Access
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Programmi MS Word käivitamisel avatakse tühi, väikemäärangutega dokument, kuhu võib hakata kohe teksti sisestama. Lühikeste dokumentide juures on soovitatav kõigepealt sisestada tekst ja alles seejärel kujundada dokument.

Arvutil kirjutamisel tasub harjuda mõningate reeglitega, mille täitmine ei tarvitse olla iseenesest mõistetav. Püüame nüüd reeglitest olulisemad sõnastada:

· Märkide sisestamine toimub klaviatuurilt kohas, kus vilgub tekstikursor
· Kirjavahemärk (punkt, koma) järgneb ilma tühikuta otse sõnale, seejärel tuleb kindlasti tühik. 
· Iga sõna vahele tuleb sisestada üks tühik. Teksti ei ole soovitav paigutada tühikutega. Tühikud peaksid esinema ainult ühekaupa.
· Selleks, et lõpetada jooksva lõigu sisestamist ja alustada uue lõiguga tuleb vajutada sõrmist Enter.
· Uuele reale üleminekuks ei ole vaja alati vajutada Enter, teksti kirjutamisel vahetab arvuti ise rida.
· Taandrida ära tee tühikute abil, vaid vajutades Tab-klahvi. 
· Poolitamiseks kasutada Ctrl + - (sidekriips täheklaviatuurilt). Miinusega ei poolitata!
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Suurtähtede või klahvide ülemiste märkide saamiseks tuleb all hoida klahv Shift ja vajutada soovitud tähe või märgi klahvile. 

Klahvi Caps-Lock abil saab sisse-välja lülitada suurtähtede saamise režiimi.

Klahvidel olevate kolmandate sümbolite saamiseks tuleb all hoida klahvi Alt_Gr ja vajutada soovitud klahvile.

Arvutil kirjutatud tekst koosneb lõikudest (paragraph). Lõik on jupp teksti, mis arvutis lõpetatakse vajutades <Enter> klahvile. Wordis ei ole vaja uuele reale minekuks Enterit (lõiguvahetust) vajutada, kuna reavahetus toimub automaatselt, s.t. kui rida saab täis, siis viib tekstiredaktor kursori automaatselt järgmisele reale. Enter vajutamine on vajalik ainult uue tekstibloki e. lõigu alustamiseks.

Visuaalse lõigu tekitamiseks kasuta klahvikombinatsiooni Shift+Enter (reavahetus).

Et olemasolev lõik jagada kaheks eri lõiguks, vii kursor kohta, kus peab lõppema esimene lõik ja vajuta Enter-klahvi.

Tühja rea saamiseks vajuta samuti Enter-klahvi. Tühja rea saamiseks esimese rea ette vii kursor selle rea ette ja vajuta Enter-klahvi.

Word loob automaatselt uue lehekülje kui vana täis saab. Mõnikord vajame sundleheküljevahetust, n. kui tahame uut peatükki uuelt leheküljelt alustada. Selleks vajuta Ctrl+Enter.

Numbreid saab sisestada ka numbriklahvistikust. Sel juhul peab põlema NumLock-tuli. Selleks vajuta numbriklahvistikul olevat NumLock-klahvi. 

Sellistes sõnades nagu „Mari-Liis“ või „Lõuna-Eesti“ kasutatakse sidekriipsu. Mõttekriips on tavalisest sidekriipsust pikem. Mõttekriipsu saamiseks vajuta Ctrl-klahvi all hoides numbriklahvistiku miinust. Seda pikemat kriipsu kasutatakse ka ühendava mõttekriipsuna, näiteks aastatel 2007–2008.

Et olemasolevasse teksti midagi vahele lisada, vii sisestuskriips hiire abil või nooleklahve kasutades soovitud kohta ja sisesta vajalik tekst.

Olemasoleva teksti üle trükkimiseks vajuta Insert-klahvi. Sel juhul asendatakse sisestuskriipsust paremal olev tekst uuega. Ülekirjutusrežiimist väljumiseks vajuta uuesti Insert-klahvi.


[bookmark: _Toc203285372][bookmark: _Toc248637387]Paranduste tegemine tekstis

Peale dokumenditeksti sisestamist tuleb töö üle vaadata, et vigu sisse ei jääks. Vea avastamisel tuleb see parandada. Teksti redigeerimine toimub toimetamiskohal. Seega tuleb kõige esimese sammuna viia kursor sinna, kus Te soovite teksti parandada.


Sümbolite kustutamiseks on järgmised klahvid:

[image: ]

[image: http://images.google.ee/images?q=tbn:LH-7iOyrx3e_KM:http://www.rdg.ac.uk/ITS/info/training/notes/word/begin/undo.jpg]Kui soovite rohkem teksti kustutada, siis võite sümbolite ükshaaval kustutamise asemel vastava teksti märgistada ja vajutada Backspace.

[image: http://images.google.ee/images?q=tbn:LH-7iOyrx3e_KM:http://www.rdg.ac.uk/ITS/info/training/notes/word/begin/undo.jpg][image: http://images.google.ee/images?q=tbn:LH-7iOyrx3e_KM:http://www.rdg.ac.uk/ITS/info/training/notes/word/begin/undo.jpg]Kui sa oled teinud kogemata midagi sellist, mida sa ei tahtnud, siis vajuta nupul Undo (tagasi) 
mis asub kiirpääsuribal.
Kui sa oled liiga palju samme tagasi läinud, siis vajuta Redo [image: http://www.mcs.vuw.ac.nz/technical/software/doc/kde/HTML/en/ktuberling/button-redo.png]
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Insert->Symbol
Teksti sisestamisel tuleb ikka ette, et on vaja sümbolit, mida klaviatuuril ei leidu, näiteks: ° ±  .
[image: ][image: ]



[image: ] Sümboli lisamiseks:
1. viige tekstikursor kohta, kuhu soovite sümbolit lisada;
1. valige Insert menüüst käsk Symbol
1. Avanevast dialoogiaknast SYMBOL valige sobiv märk 

või More Symbols



[image: ]
 
Nupule Insert klõpsates lisatakse valitud sümbol kursori asukohta. 
Sümbolite aknas real Recently used symbols on viimati kasutatud sümbolid. Siit võib neid samuti dokumendile lisada.
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Teksti märgistamise võimalused

Tihti on vaja teha operatsioone mingi suurema hulga sümbolitega (kustutada, kujundada samasuguseks, kopeerida jne). Sellisel juhul tuleb enne vastava operatsiooni sooritamist vajalikud sümbolid märgistada. Märgistamiseks on järgmised võimalused:

	Soovitud tekstiosa
	Lohistada hiirega üle märgistamist vajava teksti 

	Sõna
	Tee märgistataval sõnal topeltklõps

	Rida
	Liigu hiire kursoriga soovitud rea tekstist vasakule, nii et kursor muutub paremale osutavaks nooleks ning tee seal hiire vasaku klahviga üks klõps

	Lõik
	Tee märgistataval lõigul kolmekordne klõps

	Lause
	Hoia Ctrl all ja klõpsa lausel

	Kogu tekst
	Kiirkorraldus klaviatuurilt Ctrl + A  

	Vertikaalne tekstiplokk
	Hoida all klahvi <Alt> ja lohistada üle teksti




NB!Märgistatud tekst kuvatakse tumedal taustal!

[image: ]

Eraldi asetsevate tekstiosade märgistamiseks hoia all Ctrl klahvi ja lohista hiirega üle teksti.  

Märgistuse mahavõtmiseks - hiireklõps kusagil tekstis.
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Teksti kopeerimine ja teisaldamine

Tihti on vaja samas dokumendis sisestada sarnast teksti, samuti on mõnikord vaja kopeerida teksti ühest dokumendist teise (dokumendid võivad asuda isegi erinevates programmides või internetis). Et mitte seda teksti käsitsi uuesti sisestada, on loodud võimalused teksti kopeerimiseks ja ümbertõstmiseks.

Teksti kopeerimine

1)  Kõigepealt tuleb vajalik objekt (tekstiplokk, tabeliplokk vm) märgistada (vaata lk. 12): vii hiirekursor tekstiploki algusesse, vajuta hiire vasak nupp alla, tõmba kursoriga üle märgistatava osa ja vabasta hiirenupp.  Märgistatud tekst kuvatakse tumedal taustal!

2) 	 Seejärel tee hiire paremklõps selekteeritud (aktiivsel) tekstil ja vali korraldus Copy  
 
3)  	Nüüd vii kursor kohale, kuhu tahad info paigutada, paremklõpsa seal hiirega ja vali ilmunud menüüst korraldus Paste (kleebi). 
[image: ]


Teksti teisaldamiseks
1) Märgistada tekst, mida soovid ümber tõsta
2) Valida käsk Cut (lõikamine) 
3) Viia kursor kohta, kuhu  soovid antud teksti panna ning valida Paste.


NB! Ühe lehe piires teksti saab teisaldada ka lohistamisega:  võta hiirega selekteeritud tekst ja hiire vasakut klahvi all hoides lohista tekst uude kohta, vabasta hiire klahv.
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Töö samaaegselt mitme dokumendiga

MS Word  võimaldab töötada korraga paljude dokumentidega. See on väga kasulik juhtudel, kui Teil on vajalik kokku kompileerida uus dokument mitmest eri dokumendist  või soovite võrrelda kask dokumenti.

1. Avage mõlemad failid, mida soovite kasutada.
2. Klõpsake menüü View nuppu View Side by Side 

[image: ]
Mõlema dokumendi korraga kerimiseks nuppu Synchronous Scrolling
Kõrvutivaate sulgemiseks klõpsake uuesti nuppu View Side by Side
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Lehekülje seaded
 (
Tallinna Tervishoiu Kõrgkool. 
Kirjalike 
tööde vormistamise juhend (väljavõte):
Lehekülje vaba ruum on 3 cm vasakust ja 2,5 cm teistest servadest
)


Põhilised variandid, mis mõjutavad dokumendi väljanägemist, sisaldavad järgmist:

· vabad veerised (Margins).
· lehekülje orientatsioon (Orientation)

Määrangute tegemiseks tuleks valida menüüst Page Layout -> Margins-> Custom Margins

[image: http://www.vkg.werro.ee/krista/word/w_2003p/lehekylje_haalestus2.png][image: ]
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Teksti vormindamine. Märgi- ja lõiguvorming

Teksti vormindamine on toiming, mis annab tekstile sobiva väljanägemise ja paigutuse nii teksti ridade kui ka lehe suhtes. Teksti vormindamiseks on 2 erinevat vahendit.


1. Märgivorming- määrab kirja ilme: kirjaliigi, suuruse, värvi, tähevahed jne.
2. Lõiguvorming- määrab terve lõigu kujunduse: paiknemise, reavahed, taandread jne.
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Tallinna
 Tervishoiu Kõrgkool. Kirjalike t
ööde vormistamise juhend (väljavõte):
S
õna või lauseosa esiletõstmiseks kasutatakse rasvast kirja (
Bold). 
Tekstis allajoonimist mitte kasutada.
)Märgivorming
Märgivorming hõlmab:

· Kirja tüübi (Font) määramine
· Kirja suuruse (Font size) määramine
· Kirja laadi (Font style) määramine
· Kirja värvi (Font color) määramine

Teksti kirjatüübi, suuruse või laadi muutmiseks tuleb muudetav tekstiosa märkida ja kasutada seejärel kas...

1) Home vahekaardil Font rühmas olevaid märgivormingu muutmise nuppe:
 (
Vormingu kustutamine
)
 (
Kirja tüüp
) (
Kirja suurus
)


 (
kaldkiri
) (
rasvane
)[image: ]
 (
allajoonimine
) (
värvus
)
 (
ülemine
 ja alumine indeks
) (
SUURED tähed
)

[bookmark: _Toc203285378][bookmark: _Toc248637394]Vormingupintsli kasutamine ja vormingu kopeerimine

Kui dokumendis on mitmes erinevas kohas vaja kasutada ühesugust kujundust, siis on seda piisavalt tülikas nuppudelt või menüüst korduvalt valida. Wordis on hea võimalus olemasoleva kujunduse edasikandmiseks.

Käsitsi vormindamisel on asendamatuks abiliseks vormingupintsel [image: ] Format Painter. 
Selle abil saab kopeerida vorminguid ühest kohast teise:

1) Märgi lõik või tekstiosa, mille vormingut tahad „paljundada” ehk kopeerida

2) Klõpsa vormingupintslit , kui soovid vormingut kopeerida mitmesse kohta, siis tee topeltklõps vormingupintslil.

[image: ]

3. Pintselda üle kohad, kuhu tahad vormingut kopeerida
4. Kopeerimise lõpetab klõps vormingupintsli nupul või Esc klahv
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[image: ]

Mõned vorminduskäsud on nii vajalikud, et soovite neid kogu aeg käepärast hoida, olenemata sellest, mida te teete.

Oletame, et soovite kiiresti teksti vormindada, kuid töötate parasjagu vahekaardil Page Layout. Vormindussuvandite nägemiseks võite klõpsata vahekaarti Home, kuid on ka kiirem moodus:

Lohistage hiirega teksti valimiseks üle teksti ja osutage valikule. Seepeale kuvatakse minitööriistariba tuhmilt. Kui te osutate kursoriga minitööriistaribale, kuvatakse see selgelt ja te saate klõpsata soovitud vormindussuvandit.
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Lõiguvorming

[bookmark: _Toc156116992][bookmark: _Toc158540355][bookmark: _Toc179773663]Mis on lõik?
Tähtis tekstiosa Wordi dokumendis on lõik. Lõiguna käsitletakse kõike, mis paikneb kahe lõiguvahetusmärgi (¶-märgi) vahel. Lõiguvahetusmärk on üks nn erisümbolitest. Erisümbolite näitamist saab sisse/välja lülitada nupu Show/Hide (¶-nupp) abil
Tekstilõik lõpeb <Enter> klahvi vajutusega. Kui on vaja minna uuele reale lõiku lõpetamata, siis selleks vajutame <Shift> + <Enter>.  Kui lõpetame ühe lõigu, siis järgmine lõik tuleb sama vorminguga.
Igal lõigul võib olla oma kujundus. Erinevalt märgivormingule (kirja kujundus), mis võib hõlmata üksikuid tähti, sõnu ja lauseid, kehtib lõiguvorming (lõikude kujundus) alati tervele lõigule.

Lõiguvorming hõlmab:
1. Joondamine (Alignment) 
2. Lõikudevaheline ruum (Spacing before, after) 
3. Reavahe määramine (Line spacing) 
4. Taanete moodustamine (Indentation)

[bookmark: _Toc158540356][bookmark: _Toc179773664]Lõigu muutmiseks tuleb muudetav lõik märkida ja kasutada Home vahekaardil Paragraph rühmas olevaid lõiguvormingu muutmise nuppe:

[image: ]



 (
Tekst joondatakse nii vasak- kui ka parem
poolse serva järgi, st tekst on 
rööpjoondatud (mõlemad servad on sirged)
)

[bookmark: _Toc203285381][bookmark: _Toc248637397]1. Joondamine ehk Alignment
Joondamine tähendab, milline serv lõigul on sirge [image: ]

	Vasakjoondus
Joondamine tähendab,  milline serv lõigul on sirge. Sellel lõigul on sirge vasak serv.
	Paremjoondus
Aga sellel lõigul on sirge parem serv. Paremjoondust võiks kasutada motode puhul

	Keskjoondus
Kõik pealkirjad tuleb joondada keskele seda käsku kasutades.
	Rööpjoondus
On niisugune joondus, mille puhul lõigu mõlemad servad on täiesti sirged. See joondus saadakse sõnade vahekaugust  suurendades.




[bookmark: _Toc179773665][bookmark: _Toc203285382][bookmark: _Toc248637398]2. Lõikudevaheline ruum 

[image: Nupu pilt]Spacing (lõikudevaheline ruum) - määratakse ära, kui palju tühja ruumi jäetakse lõikude vahele. Teksti lõikudele pole vaja eraldi lisarida vahele jätta. Sellega saab Word ise suurepäraselt hakkama. Kõigepealt, nagu ikka, tuleb tekst märgistada. Seejärel klõpsake Paragraph rühma dialoogiakna noolt
[image: ]



Lõikude vahesid saad määrata lahtrist Spacing (Vahed), klõpsates noolekestega Before (enne) lahtris ja After (pärast) lahtris soovitud suuruseni.  <0 pt> on tavaline tekst, <12pt> on ühe rea vahega lõik. Mida suuremaks numbrid lähevad, seda suuremad lõikude vahed tulevad
[image: http://www.vkg.werro.ee/krista/word/w_2003p/loik4.png]
 (
Tallinna Tervishoiu Kõrgkool.
 Kirjalike 
tööde vormistamise juhend (väljavõte):
Lõiguvahe on 12 punkti 
(Spacing/After
). Töös ei kasutata 
taandridu.
)
 




 (
12 pt
)







Before - tühja ruumi hulk enne lõiku;
After - tühja ruumi hulk peale lõiku.



[bookmark: _Toc179773666]

[bookmark: _Toc203285383][bookmark: _Toc248637399] (
Tallinna Tervishoiu Kõrgkool. 
Kirjalike tööde
 vormistamise juhend (väljavõte):
Kirjatüüp Times New Roman, täh
e suurus 12 punkti, reavahe 1,5
)
3. Reavahe määramine 


Nupp Line Spacing [image: ] võimaldab muuta märgistatud teksti reavahe suurust. Vaikimisi reavahe on määratud nii, et normaalsuurusega kirja 11 pt puhul on reavahe 12 pt (1,15) 
[image: ]

[bookmark: _Toc179773667][bookmark: _Toc203285384][bookmark: _Toc248637400]4. Taanete moodustamine
Nupud Increase Indent [image: ] ja Decrease Indent [image: ] on taande suurendamiseks ja vähendamiseks. 
[image: C:\WINDOWS\Desktop\vasa_parem_taane.bmp]

Taane (indentation) pakub kasutajale võimalust jätta lõigule vasakult (left) ja paremalt (right) lisaruumi. See on üks võimalus teksti esiletoomiseks muu teksti hulgast. Peab märkima, et sellise taande suurus ei tohi olla liiga väike, mitte alla ühe sentimeetri. Liiga väike taane muudab ääre segaseks ja ei too teksti esile. Siin on taandeks kummastki äärest 2,5 cm.





Taanete moodustamiseks võib kasutada Paragraph dialoogiakna käivitit [image: Nupu pilt]
[image: ]

Special - saab lõigu esimest rida vasakule-paremale nihutada.
None - lõigu esimene rida on järgneva tekstiga samal tasemel.
First Line - taandrida, s.t. lõigu esimene rida nihutatakse paremale.
Kui palju nihutada, see tuleb valida kastikesest By.
Hanging - lõigu esimene rida nihutatakse vasakule. Kui palju nihutada, see tuleb valida kastikesest By.
[bookmark: _Toc158540357][bookmark: _Toc179773668][bookmark: _Toc203285385][bookmark: _Toc248637401]

Loetelude sisestamine ja kujundamine

[image: ]
Populaarsed täpp- ja numberloendid ning mitmetasemelised loendid asuvad Paragraph rühmas.
 (
Tallinna Tervishoiu Kõrgkool. 
Kirjalike 
tööde vormistamise juhend (väljavõte):
Loetelu osad peavad olema vormiliselt ühesugused. Loetelu punktid tähistatakse tavaliselt kas araabia numbrite või tähtedega, mille järel on ümarsulg või punkt. Loetelu järjekorda võib tähistada ka tingmärkidega.
)Loetelude tegemiseks tuleb tekst, millest Te soovite loetelu teha, märgistada ning seejärel valida kas...
Täpploend [image: Nupu pilt]
Nummerdus [image: Nupu pilt]
Mitmetasemeline loend [image: ]



NB! Võimalike täpi- või numbrilaadide nägemiseks klõpsake nupu Täpploend või Nummerdus noolt.

Mitmetasandilise numeratsiooni puhul satuvad lisatavad lõigud eelnevaga samale tasandile. Tasandi muutmiseks kasutada järgmisi nuppe: suurendamine Increase Indent [image: ]; vähendamine [image: ]Decrease Indent.
[bookmark: _Toc179773599][bookmark: _Toc179773678]
[bookmark: _Toc179773679][bookmark: _Toc203285386][bookmark: _Toc248637402] (
Tallin
na Tervishoiu Kõrgkool. Kirjalike 
tööde vormistamise juhend (väljavõte):
Kõik peatükid ja teised struktuursed osad algavad uuelt lehelt .Alapeatükke alustatakse jooksvalt leheküljelt
)Lehekülje katkestus (uue lehe lisamine)

Mõnikord on vaja uut peatükki alustada kindlasti 
uuelt leheküljelt. Selleks tuleb töö sellel lehel katkestada 
ja tekitada uus leht juurde. 

Liigu kursoriga kohta, kus soovid teha lehekülje katkestust. 
Seejärel vajuta klaviatuurilt CTRL+ENTER


[bookmark: _Toc203285387][bookmark: _Toc248637403]


Sõnaarvestus

Kui soovite teada sõnade arvu oma dokumendis, loendab Microsoft Word need teie eest. Word oskab teile öelda sedagi, mitu lehekülge, lõiku ja rida on dokumendis ning märkide arvu koos tühikutega või ilma. 

Dokumenti tippimisel loendab Office Word 2007 automaatselt dokumendi lehekülgede ja sõnade arvu ning kuvab need tööruumi allservas asuval olekuribal:

[image: ]

Kui te teete klõps sõnade arvul, siis ekraanile ilmub dokumendi statistika:

[image: ]

Saate loendada mitte ainult terves dokumendis sisalduvaid sõnu, vaid ka sõnade arvu valikus või valikutes. Sõnade loendamiseks ei pea valikud asuma järjestikku.

Valige tekst, mille sõnade arvu soovite loendada. Olekuribal kuvatakse valikus sisalduvate sõnade arv. Näiteks tähendavad kuvatavad arvud „Words:100/1440“, et valik sisaldab 100 sõna terves dokumendis sisalduvast 1440 sõnast


[bookmark: _Toc179773656]

[bookmark: _Toc203285388][bookmark: _Toc248637404]

Täheregistri muutmine

Kui soovite valmiskirjutatud teksti hiljem muuta (nt väiketähed suurtähtedeks), pole mõtet teksti kustutada ja uuesti kirjutada, vaid võib kasutada Wordi kujundusvõimalust täheregistri muutmine Font rühmas või klahvikombinatsioon <SHIFT+F3>.
[image: ]
Eelnevalt märgistage tekst, mida soovite muuta ja seejärel valige avanevast dialoogiaknast soovitav käsklus (vt järgnev tabel).
[image: ]

[bookmark: _Toc203285390]


Ääriste ja taustavärvi lisamine lõigule
[image: ]Tekstile raamjoonte lisamiseks märgista tekst ja klõpsa nupu „Borders and Shading“ (äärised ja varjustus) valikunoolt [image: ] ning avanevast loendist vali sobiv äärejoon. 
Mina soovitan raamide lisamiseks kasutada Borders and Shading dialoogiakna, sest et selles tööaknas  leiad rohkem variante, lisaks on võimalik raamida terve lehekülg, valida värvid ja varjud.
Tekstile taustavärvi lisamiseks klõpsa sakil Shading (Varjustus)  ja vali sobiv taustavärv.
[image: ]



[image: aarised]

[image: http://172.16.8.30:7778/i/perh/img/header/logo.gif]         	       MS Word 2007                                                     
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[bookmark: _Toc203285391][bookmark: _Toc248637405]Tervele lehele raamjoone lisamiseks
Page Layout-Page Borders
Klõpsa Page Borders (Lehekülje ääris) sakki ning vali sobivad jooned.
Kui Eelvaade-ala näitab soovitud joonte paigutust, klõpsa OK.
Rakenduskoht (Apply to)-alalt saad valida, kas sellise raamjoon teha kogu dokumendile, sektsioonile, kus on sisestuskriips, sektsiooni esimesele lehele, sektsiooni kõigile lehtedele peale esimese

[image: aarised_varjud2]

[bookmark: _Toc158540359]
[bookmark: _Toc179773671]
[bookmark: _Toc203285392][bookmark: _Toc248637406]
Vesimärgi lisamine dokumendile
Page Layout->Watermark
Vesimärgid on tekst või pildid, mis kuvatakse dokumendi teksti taga. Sageli ilmestavad need dokumenti või tähistavad dokumendi olekut (nt Mustand). Vesimärgid on nähtavad küljendivaates, täisekraani lugemisvaates ja prinditud dokumendis. Vesimärk on dokumendil selgelt näha, kuid ei kahjusta kirjutise loetavust
Vesimärgi lisamiseks vali Page Layout vahekaart -> Watermark->Custom Watermark

[image: ]

[image: ]



[bookmark: _Toc158540360][bookmark: _Toc179773673][bookmark: _Toc203285393][bookmark: _Toc248637407]
Teksti paigutamine mitmesse veergu

Teksti mitmesse veergu paigutamiseks tuleb kõigepealt tekst, mida Te soovite mitmesse veergu saada, märgistada.
Seejärel klõpsutage nupul Columns[image: http://images.google.ee/images?q=tbn:bSQIpy-bwJuJgM:http://www.rdg.ac.uk/ITS/Topic/WordProc/WoPW6ess01/m4745.gif] Page Layout vahekaardil ning määrake ära, mitmesse veergu Te soovite seda teksti saada.
[image: ]
[bookmark: _Toc156116998]Selle tulemusel paigutataksegi tekst mitmesse veergu. Tekst pannakse veergudesse järgmiste põhimõte järgi: Tekst voolab esimeses veerus lehekülje lõpuni, seejärel voolab teises veerus jne. Kui teksti on vähe, siis võib seda näiteks jätkuda ainult esimesse veergu. Kui Te märgistasite mingi osa teksti seest, siis ei voola tekst mööda esimest veergu mitte lehekülje lõpuni, vaid märgistatud ala lõpuni.
[image: ]Kui soovite täpsemalt määrata, kuidas teksti veergudesse panna, siis käsu More Columns abil saate seda teha:

[bookmark: _Toc203285394][bookmark: _Toc248637408][bookmark: _Toc208659551]

Veeruvahetus
Veeruvahetuse (järgmisse veergu ülemineku) leiate menüüst Page Layout - Breaks - Column
[image: ]
Veeru vahetuseks saate kasutada ka kiirklahvikombinatsiooni CTRL+SHIFT+ENTER


[bookmark: _Toc248637409]Töö pikkade dokumentidega
[bookmark: _Toc203285395][bookmark: _Toc248637410]Liikumine Word dokumendis
Vertikaalse kerimisriba allotsas ekraani paremal ääres on kolm nuppu [image: ]
 
Neist nooled viivad eelmisele või järgmisele leheküljele.  Kui klõpsata ringikujulisel nupul, siis tuleb juurde menüü, mis lubab valida ka teisi objekte peale lehekülgede, millele liikuda.

[image: ]

[bookmark: _Toc179773647][bookmark: _Toc203285396][bookmark: _Toc208659553][bookmark: _Toc248637411][bookmark: lklaver]Liikumine dokumendis klaviatuuri abil

Sümboli võrra paremale / vasakule		nooleklahvid  / 
Rea võrra üles / alla				nooleklahvid   / 
Sõna võrra paremale / vasakule			Ctrl+ / Ctrl+
Lõigu võrra üles / alla				Ctrl+ / Ctrl+
Ekraanitäie kaupa üles / alla			vajuta klahvile PageUp / PageDown
Lehe võrra üles/ alla				Ctrl+ PageUp / PageDown
Rea algusesse / lõppu				vajuta klahvile HOME / END
Dokumendi algusesse / lõppu			Ctrl+HOME / Ctrl+END 
[bookmark: _Toc203285397][bookmark: _Toc208659554][bookmark: _Toc248637412]
Liikumine soovitud leheküljele                 

Tee klõps sõnal Page, mis asub olekuribal või vajuta Ctrl+G

[image: ]

Ilmunud dialoogikasti trüki soovitud lehekülje number ja vajuta Go To nuppu või Enter
[image: ]
 




[bookmark: _Toc248637413]

Valmiselementide lisamine. Esileht

Rakenduses Office Word 2007 on kasutusele võetud koosteüksused, mida saate kasutada dokumentidele valmissisisu lisamiseks. Kui töötate mõne kindla dokumendiga (nt aruanne), saate dokumendi viimistlemiseks valida galeriist esilehe ning päise või jaluse
Esilehe lisamiseks valige Insert->Cover Page
[image: ]


[bookmark: _Toc208659555][bookmark: _Toc203285398]

[bookmark: _Toc248637414]Kiirvorming - dokumendile rakendatava laadikomplekti valimine

Alustades tööd uue dokumendiga, saate valida mitme valmis kiirlaadikomplekti vahel (näiteks Modern). Iga kiirlaadikomplekt (Style) võib sisaldada laade eri pealkirjatasemete, kehateksti, tsitaatide ja tiitlite jaoks, mis on kujundatud ühes dokumendis koos töötama.
Ühe laadikomplekti laadivärvid ja -vormingud aitavad luua pilkupüüdva ja hästi loetava dokumendi.
Teil tuleb ainult valida teie loodavale dokumendile sobiv kiirlaadikomplekt ning rakendada laadid dokumendi loomise ajal. Kiirlaadikomplekti saab ka igal hetkel muuta.
Kui soovite näha, missugune näeb kiirlaadikomplekt dokumendis välja, osutage komplektile seda klõpsamata. Kiirlaadikomplekti klõpsates rakendatakse see dokumendile. 
Kiirlaadikomplekti valimiseks klõpsake menüü Home nuppu Change Style (Muuda laade) ning osutage seejärel käsule Style Set (Laadikomplekt). 
 (
2) Office Classic
)[image: ] (
 1)WORD 2003
)[image: ] 





[bookmark: _Toc248637415]

Päiste ja jaluste lisamine

Päised ja jalused (Header and Footer) on tekst (või mõnikord ka pilt), mis kordub dokumendi lehekülgedel ülaservas ja alaservas.  Osa päise sisust on muutuv, näiteks lehekülje number tuleb igale leheküljele erinev. Päisesse või jalusesse saate lisada nt. leheküljenumbrid, kuupäeva ja kellaaja, ettevõtte logo, dokumendi tiitli või autori nime jm.

Päiste ja jaluste määramiseks tehke topeltklõps lehekülje üla- või alaveerisel, siis ekraanile kuvatakse päise- ja jaluseala ning päise ja jaluse täiendav menüü „Header and Footer Tools“
 (
Teksti eemaldamine esilehelt
)
TÄIENDAV MENÜÜ <HEADER & FOOTER TOOLS>
 (
päise- ja jaluseala
)[image: ]

Päise või jaluse eemaldamiseks esilehelt märkige täiendavas menüüs Header and Footer Tools ruut Different First Page


[bookmark: _Toc203285399][bookmark: _Toc208659558][bookmark: _Toc248637416]


Valmiskujundusega päised ja jalused
Insert->Header
Saate dokumenti lisada ka valmiskujundusega päiseid või jaluseid ning soovi korral kujundusi ka muuta. Samuti saate luua ettevõtte logo ja kohandatud ilmega päise või jaluse ja salvestada selle päiste või jaluste galeriis.
Klõpsake menüü Insert nuppu Header või Footer. 
[image: ]

[bookmark: _Toc158540362][bookmark: _Toc179773675][bookmark: _Toc203285400]



[bookmark: _Toc248637417]

Leheküljenumbrite lisamine
 (
Tallinna Tervishoiu Kõrgkool.
 Kirjalike 
tööde vormistamise juhend (väljavõte):
Kõik leheküljed alates sissejuhatusest nummerdatakse.
)Insert –> Page numbers
 
Leheküljenumbreid saate lisada nii dokumendi üla- ja alaossa kui ka veeristele; saate valida galeriis saadaolevate leheküljenumbrite kujunduste hulgast. Klõpsake menüü Insert nuppu Page numbers, loendist vali leheküljenumbri asukoht
[image: ]
· Lehekülje ülaservas (päis) – Top of page
· Lehekülje allservas (jaluses) Bottom of page
· Lehekülje veerisel – Page Margins
Pärast leheküljenumbrite lisamist saate neid muuta (saate muuta nii leheküljenumbrite vormingut, fonti kui ka suurust). Leheküljenumbrite vormingu muutmiseks klõpsake vahekaardi Insert käsku Page numbers ning seejärel käsku Format Page Numbers (Vorminda leheküljenumbrid)
[image: ]
Numbri eemaldamiseks esilehelt märkige täiendavas menüüs Header and Footer Tools rühmas Options ruut Different First Page
[bookmark: _Toc179773680][bookmark: _Toc203285401][bookmark: _Toc248637418]
Teksti täiendamine kommentaaridega
Review –>New Comment
Oma teksti on võimalik täiendada kommentaaridega, näiteks kas või selle kohta, mida te tekstis mingi koha peal täpselt mõtlesite. Kommentaare ka kasutatakse muudatusettepanekute tegemiseks. Kommentaare saab lisada Review menüüst korraldusega New Comment 
1. Märgistage tekst, mida soovite kommeteerida.
2. Klõpsake menüü Review käsku New Comment
3. Kui te olete selle ära valinud, ilmub ekraanile kommentaaride aken.
4. Sisestage oma kommentaar.

Kommentaaride kiireks peitmiseks klõpsake menüü Review jaotises Tracking nuppu Show Markup (märgistus) ning tühjendage märkeruut Comments
[image: ]
[bookmark: _Toc158540366]Üksiku kommentaari kiireks kustutamiseks paremklõpsake kommentaari ja seejärel klõpsake käsku Delete comment
[bookmark: _Toc179773681][bookmark: _Toc203285402][bookmark: _Toc248637419]Joonealused märkused 
References –> Insert Footnote
[image: ]
All- ja lõpumärkusi kasutatakse dokumendi teksti selgitamiseks, kommenteerimiseks või viidete lisamiseks. Joonealuseid märkusi ehk viiteid on võimalik lisada menüü References korraldustega Insert Footnote. 
 (
dialoogiboksi 
käivitusnupp
)

Märkusi on kahte tüüpi: 
· allmärkus[footnoteRef:2]   (Insert Footnote) [2:  lehekülje allääres olev viide] 

· lõpumärkus[footnoteRef:3] ( Insert Endnote) [3:  dokumendi lõpus olev viide] 


All- või lõpumärkus koosneb kahest lingitud osast – märkuse viitemärgist (number, või märk, mis näitab, et allmärkuses või lõpumärkuses leidub täiendavat teavet) ja vastava märkuse tekstist.

Allmärkust (või lõpumärkust) alustatakse tekstipunktist, kuhu soovitatakse viide all- või lõpumärkusele lisada. Peale korralduse Reference->Insert Footnote andmist Word lisab lehekülje allserva joone, mille all on näha viite number ja sinna on võimalik sisestada tekst.

Klaviatuuri otsetee  – allmärkuse lisamiseks klõpsake klahvikombinatsiooni CTRL+ALT+F, lõpumärkuse lisamiseks CTRL+ALT+D).

All- või lõpumärkuste vormingu muutmiseks klõpsake dialoogiboksi käivitusnuppu, ilmub dialoogiaken:

[bookmark: _Toc125262019][bookmark: _Toc125262001] (
Numbrite vorming
) (
Nummerdamisviis:
Continuous
 –nummerdamine läheb järjestikuselt läbi kogu dokumendi
Restart each page
 – alustatakse igalt leheküljelt
Restart each page
 – alustatakse igalt lehelt
) (
Millisest numbrist nummerdamist alustatakse
) [image: ]
[bookmark: _Toc95816978]
[bookmark: _Toc158540367][bookmark: _Toc179773682][bookmark: _Toc203285403][bookmark: _Toc248637420]NB! Viite kustutamiseks tuleb kustutada dokumendis olev märkuse number!


Teksti otsimine
Home –> Find
Kui sul on vaja kogu dokumendis asendada mingi üks sõna teisega, siis saad seda teha, kasutades automaatset teksti asendamist. Selleks tuleb kõigepealt asendatav sõna üles leida. Vali menüüst Home korraldus Find, siis avaneb aken
[image: ]

Find What – otsitav sõna
Find Next -  siis Word leiab esimese sõna
Reading Highlight – Hightlight All – Word märgistab kõik leitud sõnad
More - lisavõimalused
Match case – otsib teksti, arvestades suur- ja väiketähti
Find whole words only – otsib ainult terveid sõnu
Use wildcards – otsing asendusmärke kasutades. Asendusmärk ? asendab ühte suvalist märki. Asendusmärk * aga asendab suvalist tähejada. Näiteks kui otsime sõna ko*l, siis leitakse nii `kool` kui `koll` aga ka `kolmel`




[bookmark: _Toc203285404][bookmark: _Toc208659563][bookmark: _Toc248637421]
Teksti asendamine
Home –> Replace
Teksti asendamiseks vali menüüst Home korraldus Replace, avaneb aken:
 (
asendamine
) [image: ]

Find What– asendab leitud sõna
Replace with: - sisesta tekst, millega soovid asendad
Replace All – asendab leitud sõnad kogu dokumendis

[bookmark: _Toc125262020][bookmark: _Toc158540368][bookmark: _Toc179773683][bookmark: _Toc203285405][bookmark: _Toc248637422]
Õigekiri ja selle kontroll
Review->Spelling and Grammar
Õigekirja funktsiooni saate kasutada näpuvigade ja õigekirjavigade leidmiseks ja parandamiseks. Õigekirja saab kõige lihtsamini kontrollida nii, et vigastele sõnadele tõmmatakse punane laineline joon alla:
[image: ]
Selle kontrollivõimaluse saab sisse (või välja) lülitada, märkides ruudu Check spelling as you type. 


Vajutage Office Nuppu–>Word Options–>Proofing
[image: ]
[bookmark: _Toc248637423]
Kasutaja õigekirjakontroll
Parandusesoovituste kuvamiseks paremklõpsake valesti kirjutatud sõna
 (
vali õige sõna
)[image: Valesti kirjutatud sõna parandussoovitused]





Kui tekst on eestikeelne, siis tuleks enne kontrollida, et valitud keeleks oleks eesti keel. Seda saab kontrollida olekuribal, mis asub ekraani allosas
 (
keele valimiseks tee klõps!
)
[image: ][image: ]















[bookmark: _Toc248637424]Sõnade lisamine sõnastikku
Õigekirjakontrolliga töötamise korral võrdleb see dokumendis leiduvaid sõnu tööriista enda põhisõnastikus olevatega. Põhisõnastik sisaldab kõige tavalisemaid sõnu, kuid ei pruugi sisaldada konkreetseid nimesid või tehnilisi termineid. Sõnastikku sõnade lisamisega saab vältida õigekirjakontrollil neid märkimast vigadeks.


Paremklõpsake alla joonitud sõna ja valige Add to Dictionary. 
Järgmine kord seda enam veaks ei loetaks!

[image: ]


[bookmark: _Toc248637425]Wordi õigekirjakontroll

Õigekirja kontrollimiseks võib kasutada ka Wordi õigekirjakontrolli, selleks klõpsa õigekirja kontrolli nupul [image: ]   
 (
Õigekirja kontroll
)
[image: ]



Seejärel avaneb järgmine aken: 
[image: ]
Nüüd hakkab MS Word otsima kirjavigu sinu tekstist kogu dokumendi ulatuses ja pakkuma oma valikuid valesti kirjutatud sõnade asemele. 

Not in Dictionary - sellel real näidatakse dokumendist leitud valesti kirjutatud sõna
Suggestions - soovitused, millega võiks vigast sõna asendada
Ignore Once – ignoreerida seda viga ühekordselt (mitte parandada)
Ignore all – ignoreerida kõiki vigu
Add to Dictionary – lisada antud sõna sõnaraamatusse, et järgmine kord seda enam veaks ei loetaks (nt perekonnanimed)
Change – muuta Not in Dictionary: real olev sõna Suggestion: real oleva sõnaga (parandamine)
Change all – muuta kõik samasuguse veaga leitud sõnad Suggestion: real oleva sõnaga
AutoCorrect – lisab õigekirjavea ning selle paranduse automaatse korrektsiooni loetelusse, tulevikus parandab Word selle vea automaatselt.

Kui oled antud sõna kohta valiku teinud, siis liigub Word järgmise vigase sõna juurde ja nii kuni kogu dokument on üle kontrollitud.

[bookmark: _Toc158540369][bookmark: _Toc179773685][bookmark: _Toc203285406][bookmark: _Toc248637426]Pealkirjastiilide rakendamine ja sisukorra loomine

Sisukord on dokumendis sisalduvate pealkirjade loend. Sisukorra loomisel tuleb kasutada Wordi sisemisi pealkirjalaadide  (Heading1 kuni Heading9) vorminguid. Näiteks stiil „Heading 1“ on mõeldud rakendamiseks suurtele pealkirjadele.  „Heading 2“ stiil on mõeldud kasutamiseks suurte pealkirjade alampealkirjadele ja „Heading 3“ alampealkirjade alampealkirjadele jne.
[bookmark: _Toc203285407][bookmark: _Toc208659566][bookmark: _Toc248637427]Pealkirjastiilide rakendamine
Laadide kasutamiseks vajalik asub menüü Home jaotises Styles (Laadid):
[image: Vahekaardi Kodu rühm Laadid]
[image: ][image: Viiktekst 1] Kiirlaadid on professionaalse ilmega valmis laadid, mida saab kiiresi ja hõlpsalt rakendada. Kõige sagedamini kasutatavad kiirlaadid kuvatakse otse lindil.
[image: Viiktekst 2] Klõpsake seda nuppu, et näha rohkem kasutusvalmis kiirlaade.
[image: Viiktekst3] Klõpsake paani Styles avamiseks dialoogiboksi käivitit. See paan sisaldab kohandatud laade, mis te võisite ise Wordi varasemas versioonis teha, ning seal saab luua uusi või muuta olemasolevaid laade.

Nüüd kui tööpaan Styles on aktiivne...
1. Valige pealkiri, millele soovite rakendada pealkirjalaadi 
2. Klõpsake tööpaanil Style vormingut (Heading 1, 2, 3 jne) mida soovite rakendada.
NB! Kui soovitud laadi ei kuvata galeriis (nt Heading 3), vajutage Options ning valige All Styles. 

            


[bookmark: _Toc95816981][bookmark: _Toc156117008][bookmark: _Toc158540370][bookmark: _Toc179773686][bookmark: _Toc203285408][bookmark: _Toc208659567][bookmark: _Toc248637428]Sisukorra loomine
References –>Table of Contents

Sisukorra loomisel otsib Word määratud pealkirju, sordib need pealkirjatasemete alusel ja kuvab sisukorra dokumenti
1. Veenduge, et pealkirjad, mida sisukorda soovite lülitada, on vormindatud pealkirjastiilidega (Heading 1, Heading 2...)
2. NB! Klõpsake kohta, kuhu soovite sisukorra lisada
3. Valige menüü References käsk Table Of Contents –>Insert Table of Contents

Sisukorra kustutamiseks  - klõpsake menüü References nuppu Table of Content ning seejärel Remove Table of Contents
[bookmark: _Toc95816983][bookmark: _Toc148712806][bookmark: _Toc156117009][bookmark: _Toc158540371][bookmark: _Toc179773687][bookmark: _Toc203285409][bookmark: _Toc208659568][bookmark: _Toc248637429]
Sisukorra värskendamine
Kui lisate, kustutate, teisaldate või redigeerite dokumendis pealkirju või muud teksti ja soovite, et need muudatused ka sisukorras peegelduksid klõpsake hiire parema nupuga sisukorral ja valige Update Table (Värskenda tabel)
[image: ]

Küsitakse teilt, kas soovite värskendada kogu sisukorda või ainult leheküljenumbreid:
[image: ]

[bookmark: _Toc158540372][bookmark: _Toc179773688][bookmark: _Toc203285410][bookmark: _Toc248637430]Tabeli loomine
Insert –>Table

Versioonis Microsoft Office Word 2007 saate tabeli lisamiseks valida eelvormindatud tabelite hulgast  näidisandmetega täidetud  tabeli või lisada tabeli, valides soovitud ridade ja veergude arvu.
NB! Tabeli ehitamiseks klõpsake kohta, kuhu soovite tabeli lisada!
Klõpsake menüü Insert nuppu Table ning valige hiirega lohistades soovitud ridade ja veergude arv: vedage hiirekursor üle sobiva arvu lahtrite
[image: ]
Tabel tehtud ja kursor ootab esimeses lahtris - võite alustada teksti sisestamist. Lahtrist lahtrisse saab liikuda Tab-klahvile vajutades või nooleklahvide abil.
Pöörake tähelepanu, kui tabel on aktiivne, ekraanile ilmub täiendav menüü Table Tools (kus on kaks vahekaarti: Design ja Layout) - siin kuvatakse tabelitega tööks vajalikud funktsioonid ja käsud:
[image: ]




Kui aga valida tabeli loomiseks Insert –>Table–>Insert Table siis ilmub vastav dialoogiaken. Siin on võimalik valida veergude arv (Number of  Columns) ja ridade arv (Number of Rows) ja veergude laius (AutoFit). Vaikimisi on selleks Auto, mis jagab ühtlaselt kogu marginaalide vahelise ala. Soovi korral võib aga laiuse ette anda sentimeetrites.
[image: ][image: ]

[bookmark: _Toc208659570][bookmark: _Toc248637431]Tabeli joonistamine

Tabelit on võimalik ka ise joonistada.
1. Vali Insert–>Table– >Draw table
2. Hiirekursor muutub pliiatsi kujuliseks. Hiireklahvi all hoides saad selle pliiatskursori abil joonistada tabeli, veeru ja rea piirjooned.
[image: pliiats]


[bookmark: _Toc208659571][bookmark: _Toc248637432]

Ridade/veergude lisamine ja kustutamine

On kasulik teada, et kasutades Tab-klahvi viimases lahtris lisatakse tabelisse uus rida. Seega on tabeli loomisel peamine veergude arv, ridasid saab lihtsalt lisada. Tuleb aga meeles pidada, et vajutus Enter-klahvile tekitab uue rea lahtri sees, seega kahekordistub lahtri kõrgus kogu reas. 
Ridade/veergude lisamiseks mugav kasutada Table Toos–>Layout tööriistu
Klõpsake lahtrit üleval- või allpool seda kohta, kuhu soovite rea lisada
[image: ]
Insert Above – Lisa Üles
Insert Below – Lisa Alla
Insert Left –Lisa Vasakule
Insert Right – Lisa Paremale

Rea/veeru eemaldamiseks märgistage rida/veerg ja vajutage klaviatuurilt <BACKSPACE>

Veeru laiusi saab muuta abijooni hiirekursoriga vedades. Töö nõuab kindlat kätt, alustada saab teda vaid sel hetkel, kui osutate vahejoont ja kursor muutub [image: image189]kujuliseks.  Kui nüüd hiireklahv alla vajutada ja hiirt liigutada, siis liigub ka vahejoon ja kogu tabeli laius kas suureneb või väheneb. 
[bookmark: _Toc179773689][bookmark: _Toc203285411]

[bookmark: _Toc248637433]


Tabeli kujundamine täiendava menüü kasutades
[bookmark: _Toc208659573][bookmark: _Toc248637434]Vahekaart Desigh

Kui olete loonud tabeli, pakub Word 2007 mitmekesiseid võimalusi tabeli vormindamiseks. Kui otsustate kasutada tabelilaade, saate loodud tabeli vormindada ühekorraga ja vaadata enne laadi rakendamist eelvaadet, et näha, kuidas tabel mingis kindlas laadis vormindatuna välja näeb
 (
Joone paksus
)
 (
Joone laad
) (
pliiats
) (
Lahtri taustavärv
)

 [image: ]
 (
Joone värv
) (
kustutuskumm
) (
tabelistiilid
)




[bookmark: _Toc208659574][bookmark: _Toc248637435] (
Tabelipäise kordamine järgnevatel lehekülgedel
)

Vahekaart Layout 
 (
Jaota read ühtlaselt
) (
Teksti joondamine tabelis
)

										
[image: ]
 (
Tabeli sisu sortimine
) (
Jaota veerud ühtlaselt
) (
Teksti orientatsiooni muutmine tabelis
) (
Lahtrite tükeldamine
) (
Lahtrite ühendamine
)



Võite ühendada kaks või enam samal real või veerus asuvat lahtrit üheks lahtriks. Näiteks võite ühendada mitu lahtrit horisontaalselt, luues tabeli pealkirja, mis ulatub läbi mitme veeru. 1)Valige lahtrid, mida soovite ühendada. 2) Klõpsake käsku Merge Cells. 

Tabeli ruudujoonte kuvamine ja peitmine  <View Gridlines>
[image: ]
[bookmark: BM1]
[bookmark: _Toc208659575][bookmark: _Toc248637436]Tabeli uude asukohta lohistamine

Hoidke kursorit tabeli kohal, kuni kuvatakse tabeli teisalduspide[image: Tabeli teisalduspide].  Viige kursor teisalduspidemele, kursor muutub neliknooleks , nüüd klõpsake tabeli teisalduspidet ja lohistage tabel uude asukohta. 


[bookmark: _Toc125262024][bookmark: _Toc158540379][bookmark: _Toc179773691][bookmark: _Toc203285413][bookmark: _Toc248637437]Piltide lisamine
Insert -> Picture
 (
Pildi lisamine kõvakettast
) (
Pildi lisamine pildigaleriist
)[image: http://www.learnthat.com/computers/files/433/mspub6_files/image010.gif][image: ]



NB! Pildi lisamiseks tuleb esmalt märkida hiirekursoriga pildi jaoks sobiv asukoht.
Pildi  saab dokumendile lisad Insert menüüst korraldusega:
1) Picture (selle jaoks peab pilt olema eraldi failina arvutisse salvestatud). Dialoogiaknas näidake, kus soovitud fail asub ja klõpsake nupul Insert.
[bookmark: _Toc145125272]2) Clip Art (kasutatakse Wordis olevaid valmis pilte (pildigalerii)) Tööpaanilt ClipArt on võimalik paljude piltide hulgast valida sobiv. Kui pilt on valitud, siis hiireklõps pildil lisab pildi dokumenti.


Pildi kopeerimiseks internetist  www.google.ee  
1.         liikuge hiirega pildile;
2.         klõpsake pildil hiire paremat klahvi ning valige Copy;
3.         minge dokumenti ning jälgige, et tekstikursor oleks   
     seal, kuhu tuleb pilt;
4.         tehke paremklõps ja kleepige pilt korraldusega Paste.
[bookmark: _Toc179773692][bookmark: _Toc158540380][bookmark: _Toc203285414][bookmark: _Toc248637438][bookmark: _Toc179773693][bookmark: _Toc203285415]
Piltide töötlemine. Pildi suuruse muutmine

Dokumenti pilti lisades selgub tihti, et pilt on kas liiga suur või vastupidi, liiga väike. Pildi suurust dokumendis on võimalik muuta pilti ümbritsevatest ruudukujulistest punktidest, mis tekivad automaatselt, kui pilt on aktiivne. Hiirekursor muutub ruudukesel kahesuunaliseks nooleks. 
[image: ]
Hoides vasakut hiireklahvi all, saab vedades muuta pildi suurust. Nurgaruudukestest sisse- või väljapoole vedades muutub pildi suurus proportsionaalselt, vahepealsetest ruudukestest lohistades venib pilt proportsioonist välja.
[bookmark: _Toc145125273][bookmark: _Toc158540381][bookmark: _Toc179773695][bookmark: _Toc203285417][bookmark: _Toc208659578][bookmark: _Toc248637439]Pildi omaduste muutmine

Pildi omadusi (tausta, kontrastsust, tooni jm) on võimalik muuta Picture Tools menüü abil. Pildi valimisel kuvatakse täiendav menüü Picture Tools, mis sisaldab piltidega tööks vajalikke käske.

 (
kontrast
) (
heledus
)

 (
Pildi laad
)[image: ]
 (
Pildi taastamine
) (
värvitoon
)




[bookmark: _Toc203285416][bookmark: _Toc248637440]
Teksti mähkimine pildi ümber

Üks professionaalse ilme tekitamise viis on mähkida pildi ümber tekst. See funktsioon võimaldab asetada pildi teksti sisse. Vaikimisi tuuakse pilt dokumenti teksti vahele, s.t pildi kõrvale saab kirjutada teksti ainult ühe rea. Kui soovite pilti paigutada teksti sisse, taustaks vms, tuleb teha klõps pildil, valida Text Wrapping ja märgistada sobiv mähkimislaad (nt Square).

 (
Pildi äärejoon
) (
Pildi kuju
)

 (
teksti mähkimine
) (
efektid
) (
Pildi lõikamine
)[image: ]

Pildi kustutamiseks märgistage pilt hiireklõpsuga ja vajutage klaviatuurilt <Delete>.

[bookmark: _Toc145125274] 
[bookmark: _Toc158540382][bookmark: _Toc179773696][bookmark: _Toc203285418][bookmark: _Toc248637441]

Erinevate kujundite joonestamine
Insert->Shapes
Tarkvarakomplekti 2007 Microsoft Office system dokumenti võite vastavalt vajadusele lisada kujundeid ühekaupa või ühendada joonistuse või keerukama kujundi loomiseks omavahel mitu kujundit. Valida saate jooni, põhilisi geomeetrilisi kujundeid, nooli, võrrandikujundeid, vooskeemikujundeid, tähti, linte ja viiktekste. Pärast kujundite lisamist saate neile lisada teksti
Erinevaid jooni, erikujulisi nooli, mitmesuguse kujuga nelinurki, tähti, ringe, ellipseid ja muid kujundeid saab lisada vastavate nuppude abil menüüst Insert ->Shapes
 (
tekstikast
)[image: ]

Näiteks ristküliku joonistamiseks: vajutage hiire vasaku klahviga vastavale nupule, hiire vasakut klahvi all hoides joonistada sobiliku suurusega ristkülik. 
Kui on vaja joonistada korrapärast kujundit (nt. ruut, ring), siis hoidke joonistamise ajal all klahvi <Shift>


Kujundite valikust leiab huvitavaid kujundeid, mida kombineerides saab koostada erinevaid skeeme.
[image: http://koolitus.bcs.ee/images/skeem.gif][image: Automaatkujund Plahvatus tekstiga]
[bookmark: _Toc145125275]Mittevajalike objektide kustutamiseks märgistage objekt hiireklõpsuga ja vajutage klaviatuuril klahvile <Delete>.

[bookmark: UseMouse][bookmark: _Toc208659581][bookmark: _Toc248637442]Hiire kasutamine graafikaobjektide suuruse muutmisel

Graafikaobjekti mõõtmete muutmiseks klõpsake objekti ja valige see; nüüd lohistage ühte objekti ümbritsevat väikest ringikujulist reguleerimissanga nii, nagu näidatud joonisel.
Graafikaobjekti pööramiseks lohistage rohelist ümmargust pööramissanga.
[bookmark: _Toc158540383][bookmark: _Toc179773697][bookmark: _Toc203285419][image: Valitud nooleobjekt seda ümbritsevate sangakestega]
Kui soovite oma dokumendis graafikaobjekti asukohta muuta, siis asetage kursor objektile (aga mitte sanga kohale, kui objekt on valitud). Kui kursor muutub neljatipuliseks nooleks, siis lohistage objekt uude asukohta.
[image: Nooleobjekt ja neljatipuline nool]
[bookmark: _Toc179773699][bookmark: _Toc203285421]

[bookmark: _Toc248637443]

Objektide järjestamine ja grupeerimine

Joonistamise täiendav menüü (Drawing Tools) võimaldab erinevaid objekte grupeerida (Group), järjestada (Oder), joondada (Align), keerata (Rotate). 

Objektide järjestuse muutmiseks klõpsake objekti ja valige see; nüüd valige kas
Bring to Front - tuua kõige ette
Send to Back - viia kõige taha

 [image: ]

Objektide grupeerimine
Objektide grupeerimine võimaldab liigitada erinevaid objekte joonisel gruppideks. See funktsioon aitab näiteks objektide liigutamisel ja kustutamisel.
Kõigepealt märkige erinevad objektid <Shift> või <Ctrl> klahviga ning valige Group korraldus.
Objektide degrupeerimiseks valige hiirega grupeeritud objekt ja vajutage Group–>Ungroup
[image: ]


[bookmark: _Toc208659583][bookmark: _Toc248637444]
Objektide kujundamine

Objekti omadusi on võimalik muuta DrawingTools menüü abil. Objekti valimisel kuvatakse täiendav menüü Drawing Tools, mis sisaldab kujunditega tööks vajalikke käske:
 (
Objekti äärejoone värvus ja paksus
)
 (
Objekti värvus
)

 (
Objekti stiil
) (
Varju stiil
) (
Objekti kuju
)[image: ] 







[bookmark: _Toc248637445]

Tekstikastide (Textbox) kasutamine 

Mõningate dokumentide puhul on vaja teksti/pildi/tabeli kõrvale lisada veel infot. Selleks on Wordis tekstikastid.
Tekstikastide lisamiseks valige Insert/Shapes/Text Box [image: ]
Hoidke all hiire vasakut klahvi ja joonistage diagonaalselt tekstikasti suurus. NB! Tekstikasti on võimalik tõsta suvalisele kohale dokumendis.  Tekstikasti paigutamiseks haarake hiirega tekstikasti servast ja lohistage sobivale kohale. 
Tekstikasti kujundamiseks pange kursor tekstikasti servale ja valige täiendavast menüüst Text Box Tools soovitud töökäsk:
 (
Kasti varju stiil
) (
Kasti äärejoon
) (
Kasti taustavärv
)

 (
Kasti stiil
) (
Kasti kuju
)[image: ]

[bookmark: _Toc179773698][bookmark: _Toc203285420]

[bookmark: _Toc158540385][bookmark: _Toc179773700][bookmark: _Toc203285422]
 
[bookmark: _Toc248637446]Smart Art objektide (diagrammide ja skeemide) loomine
Insert->SmartArt
Enamik 2007 Microsoft Office system programmide abil loodud sisust on tekstiline, ehkki illustratsioonide abil edasi antud sisu on sageli hõlpsam mõista ja meelde jätta ning sellest lähtudes tegutseda. Professionaalse mulje jätvate illustratsioonide loomine võib olla üsna keeruline, eriti juhul, kui te pole ise kujundaja. Microsoft Office'i varasemate versioonide kasutamisel oleks ühesuuruste kujundite loomine ja täpne paigutamine võtnud palju väärtuslikku aega, mille oleksite saanud pühendada sisu viimistlemisele. Tarkvarakomplekti 2007 Office'i väljalase uue SmartArt-piltide funktsiooni abil saate aga nüüd luua profikvaliteediga illustratsioone üksnes mõne hiireklõpsuga. SmartArt-pildi abil saate visuaalselt edasi anda teavet ja ideesid. 
1. Klõpsake menüü Insert nuppu SmartArt
2. Klõpsake dialoogiboksis SmartArt-pildi valimine soovitud tüüpi ja paigutust. 
[image: ]


Mitmesuguste tüüpidega katsetamisel võite lähtuda järgmisest tabelist:
	SmartArt tüüp
	Pildi otstarve

	All
	Kõik SmartArt tüübid

	List
	Loend  - Mittejärjestikuse teabe kuvamine

	Process
	Protsess  -Protsessi või ajajoone etappide kuvamine

	Cycle
	Tsükkel  - Pideva protsessi kuvamine

	Hierarchy
	Hierarhia - Otsusepuu kuvamine; organisatsiooniskeemi loomine

	Relationship
	Seos  -Seoste illustreerimine

	Matrix
	Maatriks - Osade ja terviku vahelise seose näitamine

	Pyramid
	Püramiid - Proportsionaalsete seoste kuvamine (suurim komponent ülal või all)



Kui SmartArt objekt on valitud, klõpsake SmartArt-pildil soovitud kujundit ja tippige tekst:

[image: ]


[bookmark: _Toc248637447]
SmartArt objekti kujundamine
 (
taastamine
)
SmartArt objekti valimisel kuvatakse täiendav menüü SmartArt Toos, mis sisaldab kaht vahekaarti (Design ja Format)

 (
Smart Art stiil
)[image: ]
 (
objekti värviskeem
) (
Tüübi vahetamine
)
[bookmark: _Toc208659588][bookmark: _Toc248637448]

Kujundi lisamine
[image: ]



[image: ]Klõpsake SmartArt-objekti, millele soovite kujundi lisada. Klõpsake uue kujundi lisamiseks soovitud kohale kõige lähemal asuvat kujundit. Klõpsake menüüs SmartArt Toos/ Design nupu Add Shape (Lisa kujund) all asuvat noolt ja tehke siis uue kujundi asukoha valimiseks ühte järgmistest:
1. Add Shape After Lisa kujund pärast
2. Add Shape Before Lisa kujund enne
3. Add Shape Above Lisa kujund üles
4. Add Shape Below Lisa kujund alla
5. Add Assistant Lisa abi (on saadaval üksnes juhul, kui olete valinud organisatsiooniskeemi paigutuse). 
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Dokumendi kaitsmine - avamisparool
[image: ]
Samamoodi nagu arvuti, saate parooli abil teiste inimeste jaoks "lukku keerata" ka oma dokumendi. Dokumendi võite parooli abil lukustada juhul, kui te ei taha, et teised kasutajad seda vaadata või redigeerida saaksid. 
Dokumentide parooliga kaitsmise võimalus on kättesaadav paljudes Office'i programmides. Wordi, Exceli ja PowerPointi puhul on see täiesti sarnane.
Klõpsake Microsoft Office'i nuppu [image: Nupu pilt] ja seejärel käsku Save As.  Klõpsake menüü Toos käsku General options
[image: ]

Suvand Password to Open (avamisparool) on mõeldud dokumentide kaitsmiseks. 
Suvand Password to Modify (Muutmisparool) ei ole oma olemuselt turvafunktsioon. Selle eesmärgiks on ära hoida dokumentide tahtmatu muutmine. 
[image: Keti ja tabalukuga kaitstud dokument]
NB! Enda parooli meelespidamine on väga oluline. Parooli unustamise korral ei saa Microsoft seda teie jaoks taastada. 
[bookmark: _Toc158540386][bookmark: _Toc179773702][bookmark: _Toc203285424]

[bookmark: _Toc248637450]Dokumendi salvestamine

Info säilitamiseks kettaseadmetel ning dokumendi korduvaks kasutamiseks tuleb dokument pärast vajaliku teksti sisestamist kindlasti salvestada. Dokumendi kergemaks ülesleidmiseks võib kasutada failinimedena pikki dokumendi sisu kirjeldavaid nimesid. 
Klõpsake Microsoft Office'i nuppu[image: Nupu pilt] ja seejärel käsku Save As. 
Klaviatuuri otsetee  Faili salvestamiseks vajutage klahvikombinatsiooni CTRL+S.
Seejärel avaneb aken nimega Save As:
 (
Salvestamine
) (
Failinimi
) (
Salvestuskoht
)[image: ]
Kõigepealt tuleb oma tööle nimi anda. Selleks vaatame salvestusakna alumist äärt, kus on kirjas File name. Tee selles lahtris vasaku hiireklahviga üks klõps ja hakka klaviatuurilt tähti sisestama. Failinimi võib olla pikk kuni 255 sümbolit. Nimes võib kasutada nii suuri kui ka väikesi tähti kui ka tühikuid.
Samuti tuleb valida kettaseadet, kuhu fail salvestada (Save in)
Salvestamise kinnitamiseks klõpsa nupul Save

[bookmark: _Toc179773703][bookmark: _Toc203285425][bookmark: _Toc153010066][bookmark: _Toc158540388][bookmark: _Toc248637451]
Dokumendi ettevalmistus väljatrükiks ning väljatrükk

Kui dokument on arvutis valmis tehtud ja soovite seda ka paberile saada, tuleb see välja trükkida. Kuid enne dokumendi printimist tuleb veenduda, et teksti, piltide ja tabelite paigutus kogu dokumendi ulatuses vastaks teie soovile. Seda saab kontrollida prindi eelvaatlusrežiimis [image: ].
Office nupp–>Print–>Print Preview
[image: ]
 (
printimine
) (
Järgmine leht
) (
Prindivaate sulgemine
) (
suurendus
)
 (
Eelmine leht
)[image: ]
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Printimine
Kui olete veendunud, et info paigutus lehel on sobiv, saab asuda tööd välja trükkima. Lihtsaim võimalus printimiseks on klõpsata nupuribal nupule Print , mille järel avaneb printimise valikute aken:
[image: ]
	Korraldus
	Selgitus

	Printer/Name:
	Printeri valik: valikus olevate printerite asukohta ja funktsionaalsust oleks hea teada, see aitab kaasa parema trükise saamisele.

	Page Range
	Printimise piirkond:
All – trükitakse välja kogu dokument;
Current Page – prinditakse leht, millel asub kursor;
Pages - prinditakse soovitud leheküljed;
Selection - prinditakse märgistatud osa dokumendist.

	Copies
	Prinditavate eksemplaride arv:
Collate - eksemplarhaaval või lehe kaupa printimine.

	Zoom
 
	Pages per sheet - ühele lehele saab printida 1, 2, 4, 6, 8 või 16 lehekülge;
Scale to paper size - väljatrüki paberi suurus, näiteks kui dokument on loodud A4 paberile, valides Pages per sheet 4 ja Scale to paper size - A3 on tulemuseks ühel A3 paberil 4 lehekülge dokumendist (iga lehekülge on vähendatud 50%).
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